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About this guide 

Welcome to the laser guide! This document contains contains an overview of 

everything you need to get started with the fantastic art of laser cutting and engraving. 

In the following pages you will find instructions on how to use a subset of the features 

our laser and the associated software packages have to offer.  

 

Please take care when operating the laser. Not only is it a very expensive piece of 

machinery, but it is difficult to service. If you follow the instructions within, 

everybody will be able to enjoy the laser, and downtime will be minimal. 

 

The laser is also a potentially dangerous machine as it essentially ignites tiny 

controlled fires indoors. Just as you would not leave a fire unattended, do not leave 

this laser unattended. In addition, please read all of the notes, as there are several 

operating details that can help reduce the risk of mishap. 

 

Finally, this is a living document, so if you are experimenting with new techniques 

or software packages, and discover something that works well, please let us know. We 

would love to share your discovery with the community! 

 

 

 

 

Enjoy! 
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Laser Operation 

Glossary 

Operator pad 
 

Used to controls movement of the laser 
head and worktable. Selects, modifies, and 

executes jobs. 

 

Laser & power indicator lights 
 

The power indicator will illuminate when 
the key is in the ON position. The laser 
light will flash whenever the laser fires. 
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Main lid 
 

MUST be closed in order to complete a job. 
If it is open, the laser head will move, 

but the laser will not fire. 

 

Work table 
 

A permeable surface that allows a powerful 
vacuum underneath to suck away debris and 

fumes while materials are cut and 
engraved. 

 

 

Laser head 
 

An extremely sensitive and fragile lens 
that focuses the laser to enable precision 

cutting and engraving. 
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Chiller 
 

Ensures that water-cooled laser does not 
overheat during operation by keeping the 

water as cold as possible. 

 

On/Off Controls 
 

The “Emergency Stop” button can be hit to 
immediately power down the machine. The 
On/Off switch must be engaged in the “ON” 

position for the laser to function 
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Materials 

Acceptable Materials 

 

Natural Materials 

● Rock 

● Brick 

● Stone 

● Marble 

● Granite 

● Glass 

● Etc... 

 

Synthetic Polymers 

● Acrylic 

● Styrofoam 

● Styrene 

● ABS (Warning - Cutting leaves bad 

smell) 

● Plexiglass (engrave only - produces 

noxious gas) 

● Polycarbonate (engrave only - 

produces noxious gas) 

● Etc… 

Organic Materials 

● Wood 

● Leather 

● Plants 

● Fruit 

● Vegetables 

● Sea shells 

● Etc.. 

 

Cloths 

● Jeans 

● Cotton 

● Silk 

● Nylon 

● Dacron 

● Etc.. 

 

 

Metals - NOTE This laser is not intended to cut or mark metal. 

 

● Stainless Steel with flat side (engraving only) 

● Ferrous materials (engraving only) 
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Common Settings for Engraving and Cutting 

It is difficult to know what settings we should use to engrave every material due to the 

expected / acceptable quality and material properties. These settings should be used as 

guidelines. Be sure to test materials before beginning a cut or engraving. 

 

Material Mode % Pwr Speed 
(mm/s) 

Scan Gap 
(mm) 

Thickness Passes Notes 

Glass Engrave 12 350 .055 any 1 Use lowest power setting with thin 
scan gap. Keep glass cold with cold 
air, wet paper, or other coatings. 

Wood Engrave 14 350 .085 any 1 May experiment with masking tape to 
prevent sap from becoming hazy. 

Basswood Cut 50 15 NA 1/8 inch 1 Use lowest power with highest speed 
to completely cut material. 

Balsa Wood Cut 50 45 NA 1/8 inch 1 Use lowest power with highest speed 
to completely cut material. 

Birch Plate Cut 52 12 NA 1/8 inchh 1 Use lowest power with highest speed 
to completely cut material. 

Birch Plywood Cut 70 10 NA 3/16 inch 1 Use lowest power with highest speed 
to completely cut material. 

Plywood-RC 
Aircraft 

Cut 50 45 NA 3/16 inch 1 Quality of cut depends on wood 
density, glue content and humidity. 

Acrylic Cut 55 12 NA 1/4 inch 1+ Don’t move too slow or acrylic will 
cause surrounding areas to sag or 
catch on fire 

Acrylic Engrave 55 300 .065 any 1 Hard/brittle acrylic will engrave 
better. 

Acrylic - 
Mirrored 

Cut 40 15 NA 1/8 inch 2 Use first pass to get nearly 
through mirror backing. Use second 
pass to finish cut. 

Granite Engrave 85 150 .085 any 1 Use high powers to engrave at 
slowest speeds. May rub high 
contrast paints into the cracks, 
then wipe off … to make the image 
POP into view.  

Romark Engrave 12 325 .100 any 1 Use scan gap thick enough to 
prevent plastic from rolling into 
globs. Use only enough air to get 
into the desired color plastic. 

Plexi-Glass Cut 50 12 NA Varies (⅛ 
inch) 

1 Cut fast and hard. Make sure to get 
fumes out of work area fast. Do not 
breathe the fumes. 

Styrofoam - 
Closed Cell 

Cut 12 45 NA Varies 1 Use long focal length lens. Use 
lots of air for cooling the 
Styrofoam. Cut in thin layers, glue 
layers together. 

Styrofoam - Cut 12 25 NA Varies 1 Use long focal length lens. Use 
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Open Cell 
(squishy) 

lots of air assist to keep cool. 

Brick Cut 70 35 NA any 1 Use minimal air. Engrave with 
target slightly out of focus. Needs 
to be “engravable brick” to turn 
the sand into glass. 

Mirror (Back) Engrave 45 325 .085 any 1 Laser power effects the paint and 
heat transfers to copper /silver 
film layers. The laser continues to 
scar the glass.  

Leather Engrave 45 325 .085 any 1 Set Scan-Gap for resolution that 
you need for your design projects. 

Leather Cut 70 12 NA 1/16 inch 1 Use lowest power with highest 
speeds to completely cut through 
the material. Higher speeds may be 
obtained by also increasing power 

Anodized 
Aluminum 

Engrave 25 325 .065 any 1 Set Scan-Gap for resolution that 
you need for your design projects. 
Aluminum can take a high 
resolution. Power settings vary for 
color. 

Powder Coated 
Metal 

Engrave 25 325 .085 any 1 Set Scan-Gap for resolution that 
you need for your design projects. 
Don’t try to engrave all the way 
thru. Exposed metal may tarnish or 
rust. 

Cermark Engrave 50 300 .070 any 1+ Too high of power will damage the 
Cermark. Too low power will not 
heat Cermark to stick to the 
material. The glass/metal/ceramic 
must be warm. 
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Startup 
 

The Laser machine is expected to be powered off. The key switch is in the “OFF” position 

and the Emergency Stop button is pressed down. 

 

1. Open the main lid.  

a. Check if there is any damage from a previous user. 

b. Make sure that there isn't a cat or other animal that found a temporary place 

to sleep. 

c. Remove all materials on worktable. Check the position of the table, laser 

head, and materials. Ensure that there are no obstructions that will damage 

the laser head. The laser head may automatically traverse the table upon 

startup, and a head collision will damage the machine. 

 

2. Release the Emergency Stop Button by twisting the button. The button should pop up. 

The Emergency Stop Button must be in the “UP” position in order to power on the 

machine. 

 

3. Turn the key to the “ON” position to power on the laser 

a. Note: The laser machine will take several seconds to completely power on. 

There are normal sounds, alarms, and boot screens that occur. 

 

4. You are now ready to start a job 

 

 

 

 

 If the operator pad takes more than 15 seconds to completely turn on, then 

it might have a communications problem with the main motion controller.  
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Performing a Job 

Follow the correct startup procedure to turn on the laser 

Getting Started 

Press the Z/U button. Make sure  

Z move  is highlighted on the screen 
 

 

Press the RIGHT ARROW button to move 
the worktable down. Lower the 

worktable to provide ample clearance 
between laser head and all materials 

on worktable 
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Press ESC to return to the home 

screen. 

 

Follow the steps in Downloading a file to download your job to the laser machine. 

Aligning 

Ensure that there are no objects that might block or hit the laser head.  

Using the ARROW KEYS, move the laser 

head until it is above your material. 

 

 

Press the ORIGIN button to set the 

starting point for your job. 
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Press the FRAME button. The laser 

will rapidly trace the perimeter of 

your job.  

 

Ensure the frame is entirely above 

your material, otherwise repeat steps 

5 and 6 until a you are satisfied 

with the location of your job. 

 

Focusing 

To auto focus, press Z/U to open the 

menu. 

 

Select the  Auto focus  option and 
press ENTER. The worktable will rise 

to meet your material. When operation 

completes, the menu will close. 
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Go! 

Press START-PAUSE to begin the job 
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Things that can go wrong 

Head crash 

A head crash occurs when the laser head collides with anything in its path. This may 

cause severe damage to the laser lens, autofocus, mirrors, and motors. The laser is not 

smart, and will continue its trajectory regardless of obstacles. 

 

Preventative measures 

1. Do not put material on the worktable until the startup sequence is complete 

2. Lower the worktable when traversing the bay 

3. Use the FRAME button before the AUTOFOCUS button. The anchor point for the job may 

not be attached to the origin 

4. Make sure materials are uniform in height.  

 

If it happens 

1. Hit the EMERGENCY STOP button as soon as possible, ideally before the collision 

occurs. Always be vigilant when the laser head is in motion 

2. Turn the key to the OFF position. DO NOT open the lid or attempt to move materials. 

Seek help 

Fire 

If improper power and speed settings or materials are used, the laser may ignite a fire. 

The air system is intended to prevent small flames associated with normal operation, but 

you may need to manually extinguish larger flames and fires 

 

Preventative measures 

1. Only use pre-approved materials from reliable sources. 

2. Check the common settings for engraving and cutting section to determine proper 
operation settings.  

3. If you choose to experiment with your own, change settings in small increments 

4. Make sure that flammable materials (sap, stickers, paper backing) are removed 

before cutting and engraving 

5. Ensure that all fire extinguishing materials are on hand whenever the laser is in 

operation 

 

Extinguishing hierarchy 

0. Hit the EMERGENCY STOP button. If fire extinguishes, keep the lid closed to allow 

smoke to vent 

1. Blow / fan out 

2. Smother with fire cloth 

3. Spray water squirt bottle 

4. Spray non-corrosive fire retardant 

Using a fire extinguisher is a last resort as it will destroy the machine. Only 

use this if you are alone in the building and the whole place is burning down. 
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Breaking the worktable limit 

If a job is started too close to the edge of the worktable, the machine may attempt to 

process it off of the worktable, causing the laser to cut itself. 

 

Prevention 

1. Use the FRAME button before processing any job. Always check your frame and origin 

one more time than you think you need to! 

2. Ensure that the job position is set to ANCHOR in RDWorks. See downloading files to 
the laser for more information 

 

If it happens 

0. Hit the EMERGENCY STOP button  

1. Report any damage to a shop attendant 

Fumes 

Many materials emit fumes during cutting and engraving. The laser has a high powered 

exhaust system that contains smoke and gaseous fumes. Large and/or long jobs may overload 

the filtration system and leak fumes into the room.  

 

Prevention 

1. Ensure the exhaust system is running whenever the laser is in operation. If it 

appears to be disabled, make sure the socket switch is engaged. 

2. Only cut approved materials. See the acceptable acceptable materials list for more 
information. 

3. If you are cutting a material that may emit fumes, wait 30 seconds before opening 

the door. 

 

If fumes fill the room 

1. Stop all jobs using the START / PAUSE button. DO NOT it the EMERGENCY STOP button 

as the ventilation system will also shut down 

2. Leave the room and close the door behind you 

3. Immediately report fumes to a shop attendant 
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Shutdown  
  

1. Turn the key switch to “OFF” position or press the “Emergency Stop” button 
2. Ensure that the key switch and “Emergency Stop” button are both in the “OFF” and 

“Down” positions, respectively, before leaving the laser station 

 

 

● Do not leave the machine unattended while the laser is active.  

● Do not turn the power off and on quickly. The rush of electrical current can damage 

the power supplies. 
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Troubleshooting 

● If laser head traces job pattern but does not fire, ensure that the laser power 

switch is engaged and the lid is fully closed 

 

● If you find that a new project isn't working correctly, then try to run a project 

that you have confidence as working correctly. 

 

● Do not immediately blame the laser machine. The laser machine could malfunction for 

the following reasons: 

○ The laser machine has a bad communication with the computer,  

○ The AC voltage is wrong or fluctuating, 

○ The laser machine has encountered a power spike.   

○ The laser machine was recently moved and the frame is slightly twisted, 

○ The laser beam alignment is incorrect, 

○ The lenses or mirrors are dirty (carbon dust, sap, acrylic fumes, glass dust, 

oil, water vapor) 

○ The laser power is diminished because the mirrors are oxidized.  
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Software 

Workflow Overview 

 
The workflow is broken up into several stages 

 

1. Exterior design - You can use any tool to design a project. Your design can start 

as a png, jpg,gif etc. Really anything that can be imported into Inkscape 

a. Programs : any 

b. Input formats : any 

c. Output formats : many 

 

2. Vector conversion - We use Inkscape because it is a free, open source program that 

can export to Desktop Cutting Plotter format (.dxf). Adobe Illustrator, Inkscape’s 

expensive sibling, and the Illustrator file format (.ai), works as well. 

a. Programs : Inkscape, Adobe Illustrator 

b. Input formats : many 

c. Output format : dxf, (.ai)  

● (RDWorks can accept many file formats but we find dxf works the best. 

Look through the RDWorks import drop down menu of compatible file types 

if you wish to experiment. Note that some file types are bitmap types, 

and will not support cutting etching etc. 

 

3. Job design - RDWorks is the software that converts our vectors into cuts and 

engravings. It communicates directly with the laser, and supplies settings to the 

machine. RDWorks has a minimal design interface for touch ups and simple jobs like 

text or polygons. 

a. Program : RDWorks 

b. Input format : dxf, (.ai) 

c. Output format : rld 
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Inkscape 

Rasterized/Bitmapped Images vs Vector Art 

 

There are two types of images that we deal with in the laser 

workflow. The first image is created by organizing pixels in rows 

and columns called “rasters”. These images are great for use on 

websites, but start to lose quality when stretched or shrunk. 

Furthermore, RDWorks and the Laser machine need to read images as a 

series of lines. That’s where Vector Art comes in. Vector Art is a 

way of interpreting images as lines and polygons. It is a great way 

to ensure high-quality images at any size.  

Creating Vector Art from an Image 

1. Download an image (or export it from your 

illustration software), as a PNG, GIF, JPEG, or 

other bitmapped format. 

2. Open Inkscape and select File>Import to bring your 

image into the application. 

3. Click on your image and select Path>Trace Bitmap. 

4. Adjust the settings under “single scan” in the 

dialogue box that appears. For colorless images, 

selecting the “brightness cutoff” with a ~.5 

threshold should be sufficient. If parts of the image 

seem to be getting excluded in the preview, increase 

the threshold. 

5. Press OK, and then close out the dialogue box by 

clicking the X at the top. 

6. You now have two images, the vector graphic and the 

original raster. The vector drawing is on top, so click and 

drag to move it away from the raster image. If it is not 

obvious which image is which, zoom in on an edge. The vector 

art will be clear, while the bitmapped image seems fuzzy in 

comparison. Delete the original bitmapped image. 

Exporting to RDWorks 

In order for RDWorks to see your beautiful, 

hi-res vector graphic as such, you need to save 

it in the proper format. Choose File>Save As, 

and select “Desktop Cutting Plotter (.dxf)” from 

the file type dropdown menu. 
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RDWorks 

Laser Control 

Layers

 

RDWorks uses color coded layers to structure a laser job. To add a line or object to a 

layer, highlight it, and click on one of the colors at the bottom right. You will notice 

that the laser control panel in the upper right will update. Each layers has many 

parameters that you will need to adjust. 

Layer Parameters 

Once you have a design with layers, it is time to tell the laser how to process each 

layer. Click on the laser control panel in the upper right to open the following menu 
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General 

The general settings we will adjust are: 

● Processing mode 

○ SCAN - The laser head will pass back and forth between the lines as if it 

were a printer. This mode is used for engraving. If you wish to set a layer 

to scan, all shapes must enclose area, and the scan function will etch the 

interior area. It is good practice to check the image on the laser control 

pad to verify the processing mode was interpreted as intended. See 

downloading files to machine for details 
○ CUT - The laser will trace the lines using a constant beam 

● Min/max power 

○ Power determines how much energy the laser transfers to your material. Power 

values are given in percentages.  

○ Min and Max power should be set to the same values 

○ Set the power according to the material you are cutting, and the processing 

mode you selected. See common settings for engraving and cutting for 
recommended settings. 

○ Remember that power values are specific to this laser and its wattage. If you 

are researching power settings, be sure to reference machine make and 

wattage. 

 

● Speed 

○ Speed is measured in mm/s (millimeters per second), and it determines how 

fast the laser head passes over your material. In general, engraving is done 

at high speed (100 - 350) and cutting is done at low speeds (10 - 100) 
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Scan Settings 

Interval 

○ The interval is the distance between each pass of the laser across the 

engraving area. Intervals are generally between .1 mm and .05, although you 

may use larger intervals if you wish to create a lattice effect 

Previewing Your Job 

If you select the preview icon from the top palette, a job preview will open in a 

new window. From this screen you can view total job time, light time and cut 

parameters, and you can simulate the job in real time or at an accelerated pace. 

 

TIPS: When preparing for a complex project, this feature is useful for planning. If you 

are cutting on surfaces that will drop out from your material, you may want to first 

simulate the job to ensure that cuts that will move your material are executed in the 

proper order. 

Downloading Files to Laser Machine 

 

Once you are satisfied with your design, and all 

layers are properly configured, press the download 

button on the right hand panel near the bottom of 

the screen. 

 

 

 

 

 

 

 

IMPORTANT: Ensure that the position is set to anchor point. This ensures that the 

laser executes the job at the user-set origin. We prefer to operate the laser in 

this way as it is less error prone 

 

IMPORTANT: Do not operate the laser using the START button in RDWorks. We prefer 

that the laser is operated from the control panel as it is less prone to user 

error 
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Design 

Built-in Design Tools  

 

RDWorks has a limited design palette so we recommend using Inkscape if your project 

requires a more robust set of design tools. RDWorks is useful for adding text, and basic 

shapes to your project.  

Text 

Use the “fI” button on the left palette to add text. Select a TrueType font and set 

parameters.  

Grouping 

You may wish to group and ungroup objects to edit individual paths. As an 

example, text is created as a grouped object. If you wish to change an 

individual letter, you will need to ungroup the object  

 

● To ungroup an object, highlight it and select ungroup from the top palette 

● To group an object, highlight or select all desired components (ctrl+shift+click) 

and click the group button from the top palette.  
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Moving, resizing, rotating, slanting 

● Move: Click and drag the pink “X” in the center of the object highlight 

● Resize: click and drag one of the 8 grey boxes on the periphery of the the object 

highlight 

● Rotate & slant: Double click on the object. Use corner arrows to rotate, and edge 

arrows to slant. NOTE: When text objects are double clicked, the text preferences 

pane opens. To rotate or slant text, you must first ungroup and regroup the text 

object to remove its custom properties 

 

Importing Designs 

For complex designs, you will most likely want to import files into RDWorks. To do so, 

choose file>import and select a .dxf file. Feel free to browse the drop down menu and 

import other supported files types such as .ai (Adobe Illustrator) or .plt (AutoCAD). 

 

REMEMBER: If you wish to cut or engrave, you must import vector based design files 
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